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A b s t r a k t 

V práci je prezentovaný postup spracovania digi tálnych snímok zachytávajúcich v lákna si
nice Nostoc za účelom merania ich d ĺžky Preds tavený je algoritmus využívajúci Houghovu 
t ransformáciu na vyhodnotenie náväznost i vlákien v miestach ich priesečníkov. Algoritmus 
je demonš t rovaný na vybraných snímkach, skúmané v lákna sú separované a vyhodno tené 
sú ich d ĺžky Súčasťou práce je softvér realizujúci prezentovaný algoritmus vo vývojovom 
pros t redí Delphi. 

A b s t r a c t 

This thesis presents an image processing approach to estimating the length of cynobac-
teria strands in digitally acquired images. A n algorithm uti l izing the Hough transform 
to determine strand continuity at strand intersections is presented. The algorithm is de
monstrated on selected images, the examined strands are separated and their lengths are 
estimated. A Delphi implementation of the algorithm is included. 
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Úvod 
Medzi čas to sa vyskytujúce problémy v obore analýzy obrazu pa t r í extrakcia vlas tnost í 
objektov, k toré sa v danom obraze nachádzajú . N a to, aby mohli byť tieto objekty ana
lyzované, je najprv n u t n é ich v obraze správne identifikovať. V závislosti od skúmaných 
v las tnos t í existuje na riešenie tohto problému viacero ma tema t i ckých m e t ó d - pr ík ladom 
je Houghova t ransformácia na detekciu parametricky vyjádři te lných rovinných objektov, 
najčastejšie priamok. Situácia, kedy sa objekty v obraze prekrývajú alebo pre t ína jú , pred
stavuje p o d s t a t n é sťaženie tejto úlohy. Vychádzajúc zo samotnej podstaty obrazových dá t 
je tak čas to n u t n é metodiku obrazovej analýzy prispôsobiť konkrétnej úlohe. 

Predmetom diplomovej práce je numer ická analýza prekrývajúcich sa objektov v ob
raze - analyzované sú snímky vláknitej sinice Nostoc zachytené mikroskopom, pr ičom 
vlastnosťou, k to rá m á byť vyhodno tená , je ich dĺžka. K a ž d á zo súboru spracovávaných 
snímok obsahuje niekoľko vlákien, k toré sa v urči tých miestach pre t ína jú . R u t i n n á apli
kácia š t anda rdných m e t ó d detekcie objektov v obraze nie je v tomto pr ípade postačujúca , 
nakoľko pred vyčíslením dĺžky v lákna je n u t n é dané vlákno separovať od vlákien ostat
ných. 

V práci je preds tavený algoritmus, k to rý separáciu vlákien realizuje. Houghova trans
formácia, k to rá je nás t ro jom na detekciu priamok v šedotónovom obraze, nachádza v al
goritme nové uplatnenie - využ i tá je na lokálnu aproximáciu „sklonu" krivky v miestach, 
kde sa t á t o kr ivka p re t ína s krivkou inou. N a základe tejto informácie sú následne kr ivky 
v obraze automaticky t rasované, čo umožňuje ich separáciu odpovedajúcu v izuálnemu po
súdeniu a vyhodnoteniu človekom. Okrem „sklonu" využíva algoritmus niektoré historické 
informácie o správaní sa danej kr ivky v minulosti. 

V kapitole 1 sú uvedené vybrané definície a vety týkajúce sa b inárnych relácií, metric
kých priestorov a operácie konvolúcie, na základe k torých je neskôr pos tavená matema
t ická teór ia digi tá lneho obrazu a jeho spracovania. 

V prvej časti kapitoly 2 je definovaný digi tálny obraz a spomenu té sú jeho základné 
vlastnosti. V jej druhej časti sa nachádza m a t e m a t i c k ý opis vybraných numerických m e t ó d 
spracovania obrazu, k toré sú pri samotnej analýze použi té . 

Kapi to la 3 opisuje postup predspracovania obrazových d á t a ich pr íp ravy na proces 
separácie objektov, k toré zachytávajú. Upla tnené sú postupy a m e t ó d y z kapitoly 2 -
snímky boli l ineárne filtrované, segmentované a upravované vybranými morfologickými 
operáciami a numer ickými m e t ó d a m i . 

V kapitole 4 je preds tavený samotný algoritmus, k to rý vykonáva separáciu pre t ínajú
cich sa kriviek v b i n á r n o m obraze. Opis algoritmu je doprevádzaný ukážkou jeho krokov 
na jednej zo spracovávaných snímok. Uvedená je metodika est imácie dĺžky separovaných 
kriviek. 

Výsledky práce sú zh rnu t é v kapitole 5. Dĺžky vlákien siníc nachádzajúcich sa v spra
covávaných snímkach sú uvedené v tabuľke a zhodno t ená je funkčnosť algoritmu. 
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1 Matemat ický apará t 
V nematematickom chápaní obraz vidíme ako súbor objektov, o k torých môžme vysloviť 
úsudok, že pozostávajú z bodov. Analýza , k to rá m á byť vykonaná , si vyžaduje postup 
inverzný. Obraz už vopred považujeme za súbor bodov a až skúmajúc ich vlastnosti na
chádzame vzťahy určujúce to, k toré body sú súčasťou jedného objektu. N a m a t e m a t i c k ú 
formalizáciu týchto vzťahov potrebujeme predovše tkým a p a r á t b inárnych relácií a nie
ktoré pojmy súvisiace s met r ickými priestormi. Nasledujúce definície je možné považovať 
za všeobecne známe , ich formulácia však založená na monografii [1] a p rednáškach [2], [3]. 
Podkapitola o konvolúcii vychádza z [4]. 

1.1 Binárne relácie 

D e f i n í c i a 1.1.1 (Kar tez iánsky súčin). Nech A, B sú ľubovoľné množiny. Množinu 

A x B := {{a,b) \ a E A ŕ\b E B} 

nazveme karteziánskym súčinom množín A a B. 

D e f i n í c i a 11.1.2 | (Binárna relácia) . Nech A, B sú ľubovoľné množiny. Binárnou reláciou 
medzi množ inami A a B nazveme ľubovoľnú podmnož inu 

R C A x B. 

O prvkoch a E A, b E B povieme, že sú v relácií R, a zapíšeme a ~ R b, ak (a, b) E R. 
V opačnom pr ípade zapíšeme a b. A k p la t í A = B, o R povieme, že je A b iná rnou 
reláciou na množine A. 

N a základe toho, ako je relácia na množine určená, môžeme hovoriť o tom, či splňuje 
alebo nesplňuje nasledujúce vlastnosti. 

D e f i n í c i a 1.1.3 (Vlastnosti relácie). Nech i? je reláciou na A. Povieme, že i? je 

(i) reflexívna, ak p la t í a ~ R a pre vše tky a E A, 

(ii) ireflexívna, ak p la t í a ^ R a pre vše tky a E A, 

(iii) symetrická, ak p la t í a\ ~ R a2 =>- a2 ~ R a I pre vše tky a\,a2 E A, 

(iv) antisymetrická, ak p la t í a i ~R a2 A a2 ~ R a\ =>- a2 = a 2 pre vše tky a i , a2 E A, 

(v) asymetrická, ak p la t í a i ~ R a 2 =>- a 2 ^ R a x pre vše tky a\,a2 E A, 

(vi) tranzitívna, ak p la t í a\ ~ R a2 A a2 ~ R a% =>- a\ ~ R a3 pre vše tky a\,a2,a3 E A. 

V ý z n a m n ý m typom relácie na množine je relácia ekvivalencie, k to rá n á m umožňuje 
danú množinu na základe urč i tého vzťahu medzi jej prvkami rozdeliť. P r i analýze v kapi
tole 2 bude práve vhodne definovaná relácia ekvivalencie poskytovať spôsob, k to rý umožní 
v obraze rozlišovať objekty od pozadia a objekty medzi sebou. 

D e f i n í c i a 1.1.4 (Rozklad množiny) . Nech A ^ 0 je ľubovoľná množina . Množinu Ai C 
V (A) splňujúcu 
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(i) 0 č M, 

(ii) M1(~)M2 = 0 pre vše tky M1, M2 G M t aké , že Af x ^ Af 2 , 

(iii) UmsA4 = A-, 

nazveme rozkladom množiny A. Množiny M E M nazveme triedami rozkladu. 

D e f i n í c i a 1.1.5 (Ekvivalencia). B inárnu reláciu na A, k to rá je reflexívna, symetr ická 
a t ranz i t ívna , nazveme reláciou ekvivalencie na A. 

V e t a 1.1.1. Nech R je reklácie ekvivalencie na A. Množina 

MR := { M ^ I a G A}, kde M* = {a' e A | a ~ R a'}, 

je rozkladom množiny A. 

Relácia ekvivalencie definovaná na množine A tak t ú t o množ inu rozkladá na systém 
navzájom dis junktných podmnož in , k torých z jednotením je celá množ ina A. 

Obr. 1.1: Rozklad množiny M = {a,b,c,d,e} b iná rnou reláciou ekvivalencie R 
{(a,a), (6,6), (c,c), (d,d), (e,e), (a,b), (b,a), (d, e), (e, d)} 

Nakoľko relácie sú definované ako množiny uspor iadaných dvojíc, pomocou klasických 
množinových operácií dokážeme zaviesť aj operácie s reláciami. 

D e f i n í c i a 1.1.6 (Operácie s re láciami) . Nech R a S sú relácie medzi množ inami A a B 
a nech T je relácia medzi množ inami B a, C. 

(i) Zjednotením relácií R a S nazveme reláciu 

R U S := {(a, b) e A x B : aRb V aSb}. 

(ii) Prienikom relácií R a S nazveme reláciu 

R n S := {(a, b) eAx B : aRb A aSb}. 

íiii) Zložením relácií R a S nazveme reláciu 

T o R := {(a, c) e A x C : 36 e B t aké , že aRb A 6Tc}. 

4 



(iv) Inverznou reláciou k relácii R nazveme reláciu 

R-1 •- {(b,a) e B x A: aRb}. 

1.2 Metr ický priestor 

P r i spracovaní obrazu sa nezaobídeme bez konceptu vzdialenosti, k to rého matematickou 
formalizáciou je metrika. A p a r á t metr ických priestorov n á m mimo iné umožňuje použí
vať pojem susednosti pixelov, k torého znalosť je n u t n á už aj pri základných postupoch 
obrazovej analýzy. 

D e f i n í c i a 1.2.1 (Metrika a metr ický priestor). Nech Zobrazenie g : M x M —> 
[0, oo) splňujúce 

(i) Q(x,y) = 0 < ^ x = y 

(ii) g(x,y) = g(y,x) 

(iii) g(x,z) < g(x,y) + g(y,z) 

pre vše tky x, y, z G M nazveme metrikou na M. Dvojicu ( M , g) nazveme metrickým 
priestorom. 

Metr ika môže byť všeobecne ľubovoľná, ak splňuje vyššie uvedné axiómy. Axióm (i) 
nazývame axíom totožnosti - hovoríme, že metrika rozlišuje body. Axióm (ii) je axióm 
symetrie a axíom (iii) je nazývaný trojuholníková nerovnost. Medzi najznámejšie a najbe-
žejšie používané metriky p a t r í euklidovská metrika, k to rá formalizuje in tui t ívne chápaný 
pojem vzdielnosti v reálnej rovine. V kontexte digi tá lneho obrazu sa však nepohybujeme 
v reálnej rovine, a vhodnejš iou (no nie jednoznačnou) voľbou sa ukazujú byť metriky 
súčtová a maximová. 

D e f i n í c i a 11.2.2 | (Vybrané metriky). Nech M = M™, n G N . Met r iku definovanú 

n 
Qx{x,y) := \xk ~ Vk\ (1-1) 

k=l 

nazveme súčtovou (manhattanskou) metrikou. Met r iku definovanú 

g2(x,y) :=(j2(xk-yk)2Y (1.2) 

nazveme euklidovskou metrikou a metriku definovanú 

Qoo(x,y) := m a x { | x i - yx\, | x 2 - y 2 | , \xn - yn\} (1.3) 

nazveme maximálnou (Chebyshevovou) metrikou. 

V predchádzajúcich definíciách p redpok ladáme , že M je podmnož inou W1. Pozname
najme však, že nakoľko p la t í Z n C M™, metriku môžeme používať aj v n-rozmernom 
celočíselnom obore, alebo jeho ľubovoľnej neprázdnej podmnož ině . 
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D e f i n í c i a 1.2.3 (Guľa). Nech ( M , g) je metr ický priestor, XQ G M a r je k l adná reá lna 
konš tan ta . Množinu 

Br(x0) '•= {x G M : £>(xo,£) < t } 

nazveme otvorenou guľou so stredom v bode XQ a polomerom r . Množinu 

£? r [x 0 ] '•= {x G M : g(x0,x) < r} 

; i .4) 

;i .5) 

nazveme uzravretou guľou so stredom v bode xo a polomerom r. Špeciálne, guľu s polo
merom r = 1 nazveme jednotkovou guľou. 

P o z n á m k a 1.2.1. Pre e G M + nazveme Oe(a;o) := Be(xo) epsi lonovým okolím (e-okolím) 
bodu XQ. 

1 
i ' 1 

1 

- l \ 0 

(a) - 1 

/ 1  A  

(b; 

0 

-1 

1 -1 0 - l \ 0 

(a) - 1 

/ 1  A  

(b; 

0 

-1 (c) -1 

Obr. 1.2: Jednotková guľa v M x M so stredom v bode (0, 0) pri použi t í metriky (a) Q\ (b) 
Q2 (c) Qoo 

1.3 Konvolúcia 

D e f i n í c i a 11.3.11 (Konvolúcia) . Nech / , h : M —>• M . Funkciu 

/

oo 
/ ( í ) Ä ( í - T ) d T 

-oo 

nazveme konvolúciou funkcie / s konvolučným jadrom h. 

; i .6) 

V e t a 1.3.1 (Vlastnosti konvolúcie). Nech f,g, a, h sú reálne funkcie reálnej premennej 
a nech a je reá lna konš tan ta . Pre konvolúciu pla t í 

(i) / *9 = 9* f; 

(ii) / * (g * h) = (f * g) * h, 

(iii) f*{g + h) = {f*g) + {f*h), 

(iv) a(f * g) = (af) *g = f * (ag). 
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Komutat iv i ta n á m potom umožňuje v definícii 1.3.1 použiť ekvivalentný zápis 

/

0 0 

f(t-r)h(t) dr. 
- 0 0 

; i .7) 

A b y konvolúcia našla svoje uplatnenie v obore spracovania digi tá lneho obrazu, je n u t n é 
ju najprv zovšeobecniť pre funkcie dvoch premenných . 

D e f i n í c i a 11.3.2 | (Konvolúcia funkcie dvoch premenných) . Nech / , h 
Funkciu 

x K -> 

/ f(a,b)h(x-a,y-b)dadb 
- 0 0 J—00 

/

0 0 ľ 0 0 

/ f(x — a,y — b)h(a,b)dadb. 
- 0 0 J—00 

; i .8) 

;i .9) 

nazveme konvolúciou funkcie / s konvolučným jadrom h. 

Argumentom takto definovanej konvolúcie je reá lna funkcia dvoch reálnych premen
ných. V nasledujúcej kapitole však zavedieme digi tálny obraz ako zobrazenie s celočísel
n ý m definičným oborom. Budeme preto potrebovať diskrétnu konvolúciu, k to rú získame 
n a h r a d e n í m integrálov definícii 1.3.2 konečnými sumami. 

D e f i n í c i a 1.3.3 (Diskré tna konvolúcia funkcie dvoch premenných) . Nech / : Z x Z —> 
M , g : Z x Z —y M . Funkciu definovanú 

(f*g)U,k) :=J2J2f^~m^k~n)9( m, n] [1.10) 

nazveme diskrétnou konvolúciou funkcie / s konvolučným jadrom (maskou) g. 

Konvolúcia je zák ladom procesu lineárnej filtrácie obrazu, k to rá bude opísaná v časti 2.2. 

f (j, k) 
f*9 

f*9(j, k) 

f <J 

Obr. 1.3: Diskré tna konvolúcia 
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2 Vybrané metódy spracovania obrazu 
Z ma temat i ckého pohľadu obrazom rozumieme zobrazenie priraďujúce bodom svojho defi
ničného oboru, nazývaných pixelmi, jasovú hodnotu. Toto zobrazenie môže byť všeobecne 
definované na akejkoľvek podmnož ině reálnej roviny. Nakoľko však cieľom práce je spra
covanie obrazu digitálneho a s amo tný proces digitalizácie n e m á na uvedené realizované 
postupy dopad, budeme v nas ledujúcom texte uvažovať výh radne obraz digitálny, a teda 
už v jeho definícii budeme predpokladať konečnosť jeho definičného oboru. Obsah tejto 
kapitoly vychádza p r imárne z l i terárnych zdrojov [4], [5], [6] a [7]. Sekcia 2.5 týka júca sa 
matematickej morfológie je založená na monografiách [8] a [12]. Opis Houghovej transfor
mácie v čast i 2.7 sa opiera o vedomosti vychádzajúce z [11] a [14]. V neposlednej rade sú 
využi té niektoré poznatky z [13]. 

2.1 Obraz a jeho vlastnosti 

D e f i n í c i a | 2 . 1 . l | (Obraz). Nech M = {1, 2 , . . . , h} x { 1 , 2 , . . . , w}, kde h, w e N a nech 
R = { 0 , 1 , . . . , 2k - 1}, kde k G N . Šedotónovým obrazom (s t ručne obrazom) o rozmeroch 
h x w a, s bitovou hĺbkou k potom nazveme zobrazenie 

i: M -)• R. 

Hodnotu i(p) pixelu p = (j, k) nazveme jasovou alebo pixelovou hodnotou pixelu p. Špe
ciálnym p r ípadom obrazu je binárny obraz, k to rého obor hodnô t R obsahuje práve dva 
prvky, spravidla 

R = { 0 , 1 } . 

Niekedy ďalej býva vhodné obraz zapisovať v maticovom tvare, k to rý odpovedá rozmiest
neniu pixelov v rovine a je daný predpisom 

I = [ijk], kde ijk = i(j,k). 

Konečnosť oboru hodnô t n á m dovoľuje pre obraz i\ zadefinovať obraz nový, k to rý je 
k %2 v istom zmysle opačný. Taký to obraz je nazývaný komplement obrazu %\. 

D e f i n í c i a 2.1.2 (Komplement obrazu). Nech %\ a %i sú obrazy o rozmeroch h x w 
s bitovou hibkou k. Obraz nazveme komplementom obrazu ži, ak 

Í2(j, k) = (2k - 1) -ii(j,k) pre vše tky j = l,...,w, k = l,...,h. 

P o z n á m k a 2 .1 .1 . B iná rna relácia d a n á 

p ~ q i(p) = i(q) (2.1) 

na množine M b inárneho obrazu i : M —>• {0,1} je reláciou ekvivalencie a podľa vety 1.1.1 
tak rozkladá M na podmnož iny 

M0 = {peM\ i (p) = l } , 

MB = {pe M \ i (p) = 0}, 
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0 0 0 0 0 0 0 1 1 1 1 1 1 1 

0 0 1 0 1 1 0 1 1 0 1 0 0 1 

0 1 1 0 1 0 0 1 0 0 1 0 1 1 

0 1 1 0 0 0 0 1 0 0 1 1 1 1 

0 1 1 1 0 0 0 1 0 0 0 1 1 1 

pr ičom 

Obr. 2 .1 : B inárny obraz (vľavo) a jeho komplement (vpravo). 

MQ n MB = 0, MQ u M B = M. 

Zobrazenie i je zároveň charakteristickou funkciou množiny MQ. Potom je zrejmé, že ak 
poznáme definičný obor b inárneho obrazu, množ ina M o daný obraz jednoznačne určuje. 
Pixely p G M o bývajú v kontexte rozpoznávania objektov nazývané objektové pixely, a g e 
M b pixely pozadia. A k potom hovoríme o objektoch v obraze, resp. pozadí obrazu, m á m e 
na mysli jeho objektové pixely, resp. pixely pozadia. V pr ípade , že potrebujeme v obraze 
rozlišovat nie len objekty od pozadia, ale aj objekty medzi sebou, musíme zadefinovať 
pojem susednosti pixelov. 

0 0 0 0 0 0 0 

0 0 1 0 1 1 0 

0 1 1 0 1 0 0 

0 1 1 0 0 0 0 

0 1 1 1 0 0 0 

Obr. 2 . 2 : B inárny obraz (vľavo) a jeho rozklad reláciou ekvivalencie 2.1 (vpravo). 

D e f i n í c i a 2.1.3 (Susednosť pixelov). Nech r] je symetr ická b iná rna relácia na M . O pi-
xeloch p a q povieme, že sú 77-susedné, ak 

(p, q) G rj. 

D e f i n í c i a | 2.1.4 | (Cesta). Nech A C M , n G N . Postupnosť pixelov 

p = po, ..., pn = q, kde pk e A pre k = 0, . . . , n, 

nazveme rj-cestou (digitálnou krivkou) v A medzi p a g, ak 

Pk-i a pk sú 77-susedné pre vše tky k = 1, . . . , n. 
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Pr i rodzené číslo n nazveme dĺžkou cesty (digitálnej kr ivky) . Ďalej povieme, že t á t o cesta 
je jednoduchá, ak pu ^ Pi P r e vše tky indexy k, l G { 1 , . . . , n}, k ^ l. 

D e f i n í c i a | 2.1.5 | (Spojené pixely). O pixeloch p, q G A C M povieme, že sú 77-spojené 
v A , ak medzi p a q existuje 77-cesta v A. 

D e f i n í c i a | 2.1.6 | (Súvislá podmnož ina ) . Nech A C M , A ^ 0 . O množine A povieme, 
že je í7-súvislou podmnož inou , ak ľubovoľné p, q G A sú 77-spojené v A. 

Nakoľko definícia 2.1.4 pr ipúšťa t r iviálne cesty nulovej dĺžky, b iná rna relácia „byť rj-
spojené v Au je reflexívna. Navyše, už v definícii 2.1.3 p r edpok ladáme symetriu. Ďalej 
je ľahké vidieť, že t á t o relácia je t r anz i t ívna - ak existuje 77-cesta medzi p a q a existuje 
77-cesta medzi q a r , potom postupnosť 

P: q, ...r 

je 77-cestou medzi p a r . B iná rna relácia „byť 77-spojené v Alí je tak reláciou ekviva
lencie a podľa vety 1.1.1 množinu A rozkladá na 77-súvislé podmnožiny, k toré nazveme 
^-komponenty. 

Relácia r] môže byť zavedená rôzne - stačí, že splňuje predpoklady definície 2.1.3. 
V práci však budeme rozlišovať len dve, a to 

(j), q) G 774 práve vtedy, keď p 7̂  q A Qi(p, q) < 1, 

(p, q) G 778 práve vtedy, keď QOO(P,Q) = 1-

kde Qi a sú metriky zavedené v časti 1.2. Ľahko si vš imneme, že definičný obor obrazu 
spolu s jednou z met r ík g1, g^ tvor í metr ický priestor. 

+ + + + + + + + + + + 

+ + + + + + + 
\ \ \ \ 

\ \ \ \ 
+ + + 

+ + + + + 
\ x v x 

+p 
\ \ \ \ 

\ \ V X 
+ + 

+ + + + + + + 
\ \ \ \ 

\ \ V s 
+ + + 

+ + + + 

+ 

+P 
+ 

+ 

+ + + + + + + + + + + + + 

Obr. 2.3: P ixe l p, množ ina JV4 (p) a množ ina A/š (p) • 

S cieľom zjednodušenia budeme namiesto 774-susednosti, resp. r?8-susednosti používať 
výraz 4-susednosť, resp. 8-susednosť. Množinu 4-susedných, resp. 8-susedných pixelov pi-
xelu p obrazu i : M —>• R označme 

K4(P) :={qeM\ (p, q) G 774} resp. Mf{p) := {q G M \ (p, q) G 778}. 
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Ďalej označme Oi(p) množinu tých 8-susedných pixelov pixelu p obrazu i : M —y {0,1}, 
k toré sú objektové, t. j . 

Oiip) :={qeN!{p)\i{q) = l}. (2.2) 

2.2 Lineárna filtrácia 

Nakoľko obraz je podľa definície 2.1.1 funkciou dvoch celočíselých premenných , môžeme 
n a ň aplikovať operáciu diskrétnej konvolúcie dvoch p remenných definovanej v časti 1.3. 
T ú t o operáciu nazývame lineárna filtrácia alebo lineárny filter. 

D e f i n í c i a 2.2.1 (Lineárna filtrácia). Nech %\ je obraz s rozmermi h x w a g je zobrazenie 

{-a,..., 0 , . . . , a} x {-b,..., 0 , . . . , b} ->• Z , a, b e N . 

Obraz %i s rozmermi h x w a, pixelovými hodnotami 

a b 

Í2(j,k)= Z) g(s,ť)i(j + s,k + ť) 
s=—a t=—b 

nazeveme lineárnou filtráciou obrazu i\ s konvolučným jadrom g. Konvolučné jadro môžme 
zapísať v tvare (2a + 1) x (26 + 1) matice G = [gjk], kde 

9jk = g(j - a - l,k - b - 1). 

Mat ica G tak m á nepá rny počet st ĺpcov, nepá rny počet riadkov a prvok, k to rý sa 
v nej nachádza „upros t red" , odpovedá hodnote g(0,0). N a základe výberu konvolučného 
jadra rozlišujeme dva v ý z n a m n é typy l ineárnych filtrov: 

(i) filter typu horná priepust, 

(ii) filter typu dolná priepust. 

Fil tre typu dolná priepust sú zák ladnom väčšiny m e t ó d vyhladzovania obrazu. Nahra
den ím hodnoty pixelu (j, k) v h o d n ý m váženým priemerom hodnô t pixelov z jeho okolia 
dochádza k redukcii rozdielu v jasovej hodnoty medzi susednými pixelmi. Použ i t ím filtru 
typu dolná priepust dochádza v obraze k pot lačeniu vysokých frekvencií, zatiaľ čo frek
vencie nízky sú zachované. Váhy, k toré sú pri výpoč te priemeru použi té , sú dané prvkami 
konvolučnej matice. Voľbou 

G — G r 

1 

011 + 012 + • • • + 9 

011 012 

021 022 

. 0 n l 0 n 2 

0 1 n 

0 2 n 
kde gij = 1 pre vše tky i, j. 
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dos távame n x n filter klzavého priemeru. A k za prvky g^ zvolíme hodnoty aproximujúce 
dvojrozmernú Gaussovu funkciu. 

G 3x3 
1 

16 

1 2 1 
2 4 2 
1 2 1 

G 5x5 
1 

256 

1 4 6 4 1 
4 16 24 16 4 
6 24 36 24 6 
4 16 24 16 4 
1 4 6 4 1 

dos távame Gaussov filter. 

Obr. 2.4: Pôvodný obraz, jeho úprava filtrom klzavého priemeru 3 x 3 a 
Gaussovym filtrom 5 x 5 . 

Naopak, filtre typu ho rná priepust obraz zostrujú. Pixelová hodnota pixelu (j,k) je 
opäť n a h r a d e n á váženým priemerom hodnô t pixelov z jeho okolia - váhy sú však volené 
tak, aby sa ich jasový rozdiel zvýšil. Dochádza tak k pot lačeniu nízkych frekvencií, zatiaľ 
čo vysoké frekvencie sú zachované. P r ík l adom filtru typu dolná priepust je l ineárny filter 
s konvolučným jadrom 

Fil t re typu dolná priepust nachádza jú využit ie pri pot lačovaní šumu v obraze. Na 
d ruhú stranu, filtre typu h o r n á priepust síce obraz doostria, amplifikujú však aj šum, 
k torý sa v nich nachádza . 

2.3 Mediánová filtrácia 

Podobne ako filter lineárny, mediánový filter upravuje jasovú hodnotu pixelu p = (j, k) 
obrazu i\ na základe jasových hodnô t pixelov z jeho okolia. Namiesto váženého priemeru 
týchto hodnô t je však použi tý ich medián , čím je pot lačený nežiadúci vplyv impulzného 
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šumu. A k za okolie pixelu p považujeme množinu jeho 8-susedných pixelov, po filtrácii 
dos távame obraz z 2 , k torého jasové hodnoty sú 

i2(p) := median - l,k - 1), i ( j - l , f c ) , i ( j - l , / c + l ) , 

i(j,k-l), i(j,k + l), 

i(j + l,k-í), i{j + l,k), i(j + l,k + í)}. 

(2.3) 

2.4 Prahovanie 

V časti 2.1 bolo ukázané , že ak pracujeme s b iná rnym obrazom, dokážeme jeho definičný 
obor bez veľkej snahy rozložiť na dve triedy - množinu objektových pixelov a množinu pi
xelov pozadia. A k teda chceme rozlišovat objekty od pozadia v obraze šedotónovom, stačí 
n á m tento obraz v h o d n ý m spôsobom previesť na obraz binárny. J e d n ý m z naj jednodušš ích 
spôsobov, ako tento prevod docieliť, je prahovanie. 

Prepokladajme, že obraz zachytáva, voľné povedané , „svetlé" objekty na „ t m a v o m " 
pozadí . Proces prahovania obrazu %\ : M —f R potom spočíva vo vytvorení b inárneho 
obrazu 

/ , n Í 1 ak ii(j,k)<T. 
* 2 : M ^ { 0 , 1 } , kde i2(j,k):=\ . T . ' ' 

10 ak ii{j,k) > T, 
(2.4) 

kde T e i? je prahová hodnota. P ixely b iná rneho obrazu s hodnotou 1 sú potom ob
jek tovými a pixely s hodnotou 0 sú pixelmi pozadia. Hodnotu T dokážeme určiť napr. 
v izuá lnym posúden ím histogramu obrazu - za platnosti predpokladu vzájomne rôzneho 
jasu objektov a pozadia je histogram obrazu bimodálny a prirodzenou voľbou pre prah T 
je tak lokálne minimum nachádzajúce sa medzi vrcholmi histogramu. 

Obr. 2.5: Pôvodný obraz a b inárny obraz získaný jeho prahovaním. 

V publikácii [9] je preds tavený i teračný výpočet , k t o r ý m je proces voľby prahovej 
hodnoty T možné automat izovať: 

(i) V kroku t = 0 zvolíme poč ia točnú hodnotu = ^ - Y!J=\ Sfc=i k) 

ii) P r ahovan ím zostroj íme množinu MQ* objektových pixelov obrazu a množinu M g 
pixelov pozadia. 

(*) 
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(iii) Vyčíslime 

(t) — L - J2 ÁJ, k), (*) 
|M<*> 

E 
(j,k)&M^ 

ÁJ,k). 

(iv) Položíme T^ť+1) = (/Xq-1 + n^)/2 a pokračujeme od bodu (ii). 

(v) Výpočet zas tavíme po dos iahnut í podmienky — T^ť+1) | < e pre zvolené e G M . 

Klasické prahovanie môže zlyhať, ak je pozadie obrazu nerovnomerné - op t imá lna 
prahová hodnota môže byť pre jeho rôzne čast i výrazne odlišná. V takom pr ípade je n u t n é 
prahovať adaptivně - obraz rozdeliť a jeho čast i prahovať samostatne. Definičný obor M 
obrazu i : M —>• R delíme na d is junktné , vo väčšine p r ípadov obdĺžnikové podmnožiny, 
k torých z jednotením je celá množ ina M. A k to s i tuácia vyžaduje, proces je možné ďalej 
zdokonaliť u rčen ím vlastnej prahovej hodnoty pre každý pixel obrazu vhodnou m e t ó d o u 
interpolácie medzi p rahovými hodnotami jeho častí . 

T, 

T. 

T , 

T 10 

-To 

'Tr, 

T 11 -Z 12 

Obr. 2.6: Obraz a jeho rozklad na 12 podmnož in s v las tnými p rahovými 
hodnotami T i , . . . , Tí2. 

2.5 Morfologické operácie 

V súlade s poznámkou 2.1.1 sa môžeme na objekty v b iná rnom obraze pozerať ako na 
množiny pixelov. Vychádzajúc zo základných množinových operácií , m a t e m a t i c k á mor
fológia poskytuje teoret ický a p a r á t umožňujúci skúmať a spracovávať tvar obrazových 
š t ruk tú r . Základne morfologické operácie sú definované p ros t redn íc tvom známych operá
cií zjednotenia, prieniku a komplementu, a o niečo menej používaných operácií t ranslácie 
a reflexie. 

D e f i n í c i a | 2.5.11 (Reflexia množiny) . Nech A C Z . Množinu 

A = {b | b = - a , kde a e A} 

nazveme reflexiou množiny A. 
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A 

(0,0) (0,0) 

Obr. 2.7: Reflexia Ä množiny A. 

A 

D e f i n í c i a 2.5.2 (Translácia množiny) . Množinu 

(A)z = {b\b = a + z, kde a e A} 

nazveme transláciou množiny A bodom z = (zi, z2) G Z 2 . 

A 

+ + + 

Obr. 2.8: Translácia (A)z,z = (0,1) množiny A. 

2.5.1 D i l a t á c i a a e r ó z i a 

Nasledujúce definície p reds tavujú základné morfologické úpravy b iná rneho obrazu. Mno
žinu jeho objektových pixelov upravujú p ros t redn íc tvom štruktúrneho elementu. Medzi 
základné operácie patria di la tácia a erózia, pomocou k torých následne zadefinujeme ope
rácie otvorenia a uzavretia. 

D e f i n í c i a 2.5.3 (Dilatácia množiny) . Nech A, B C Z 2 . Množinu 

A © B := {z G Z 2 I (B)z nAjí0} 

nazveme dilatáciou množiny A š t r u k t ú r n y m elementom B. Ekvivalentne, 

A® B := ( J (A)b. 
b&B 

D e f i n í c i a 2.5.4 (Erózia množiny) . Nech A, B C Z 2 . Množinu 

A e B := {z G Z 2 I (B)z C A} 
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nazveme eróziou množiny A š t r u k t ú r n y m elementom B. Ekvivalentne. 

A e B:= f) (A)_b. 
bes 

P o z n á m k a 2.5.1 (Rozmer a značenie š t r uk tú r neho elementu). Š t ruk tú rny element B G 
1? nazveme š t r u k t ú r n y m elementom (rozmeru) (2n + 1) x (2n + 1), ak 

n = maxjs} , kde S = {s \ s = m a x - ^ , b2}, {bi, b2) G B} (2.5) 
ses 

a zapisovať ho budeme v tvare mriežky 

B (2.6) 

pr ičom na pozíciu bj^ zapíšeme symbol „ 1 " , ak (j, k) G B, a symbol „ x ", ak (j, /c) ^ -B. 

Za predpokladu, že poč ia tok (0, 0) G B, výsledkom dilatácie A © B je množ ina obsa
hujúca vše tky body množiny A a tie body, k toré patria do množiny A posunutej o b G B. 
Dilatácia tak množinu objektových pixelov rozširuje. Výsledkom erózie A Q B je množ ina 
bodov, k toré patria zároveň do A a do A posunutej o —b, b G B. Erózia potom mno
žinu objektových pixelov zužuje. Všeobecne, pixel (j, k) b iná rneho obrazu i je po erózii 
vyhodno tený ako objektový práve vtedy, ked 

i(j+ b1,k + b2) = 1 pre V (b1, b2) G B. (2.7) 

Obr. 2.9: Pôvodný b inárny obraz, b iná rny obraz po dilatácii , b iná rny obraz po 
erózii a uži tý š t r uk tú rny element 2.6. Hranice pixelov sú zvýraznené za účelom 
prehľadnost i . 

V e t a 2.5.1 (Vlastnosti di latácie a erózie). Nech A,B,Bi,B2 G Z 2 . Potom pla t í 

(i) (A © Bi) © B2 = A © (Bi © B2), 

(ii) (A © B i ) © B2 = A © (B1 © £2), 

(iii) (A © Bf = Ac © B, 
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Asociatívnosť (i) n á m umožňuje implementovat „veľké" dilatácie ako niekoľko po sebe 
nasledujúcich „malých" dilatácii . Podobne, vlasnosť (h) umožňuje to isté pre eróziu. Pred
pok ladáme pri tom, že š t ruk tú rny element B dokážeme vyjadriť ako 

B = B1®B2®---®Bn, n G N . 

Vzťah (iii) vyjadruje dualitu týchto operácii - d i la tácia objektových pixelov je to isté, 
ako erózia pozadia s reflektovaným š t r u k t ú r n y m elementom. Vďaka dualite nie sme pri 
implementáci i nú ten í uvažovať obe operácie zároveň - eróziu objektov v obraze doká
žeme vykonať p ros tedn íc tvom dilatácie pozadia a naopak. Navyše je postačujúce, aby 
sme dokázali tieto operácie vykonávať na množine objektových pixelov a zároveň aby sme 
dokázali z obrazu vytvoriť jeho komplement. Dilatácia , resp. erózia pozadia obrazu je 
potom komplementom dilatácie, resp. erózie množiny objektových pixelov komplementu 
komplementu pôvodného obrazu. 

2.5.2 U z a v r e t i e a o t v o r e n i e 

Di la tácia š t r u k t ú r n y m elementom B a nás ledná erózia t ý m t o elementom umožňuje z ob
razu odstrániť š u m v podobe „dier" v množine objektových pixelov, t. j . nežiadúce pixely 
pozadia spôsobujúce nesúvislosť objektov. Naopak, erózia a nás ledná di la tácia z obrazu 
odstaňuje šum v podobe nežiadúcich objektových pixelov. Tieto operácie sú nazývané 
uzavretie a otvorenie. 

D e f i n í c i a 2.5.5 (Uzavretie množiny) . Nech A, B C Z 2 . Množinu 

A • B := (A © B) e B 

nazveme uzavretím množiny A š t r u k t ú r n y m elementom B. 

D e f i n í c i a 2.5.6 (Otvorenie množiny) . Nech A,B C Z 2 . Množinu 

A o B := (A e B) © B 

nazveme otvorením množiny A š t r u k t ú r n y m elementom B. 

Obr. 2.10: Pôvodný b inárny obraz, b iná rny obraz po otvorení , b inárny obraz po 
uzavret í a uži tý š t r u k t ú r n y element 2.6. Hranice pixelov sú zvýraznené za účelom 
prehľadnost i . 
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2.5.3 H i t - o r - m i s s t r a n s f o r m á c i a 

Podmienka 2.7 hovorí, k toré pixely z okolia skúmaného pixelu musia byť objektové, aby 
bol aj skúmaný pixel po erózii vyhodno tený ako objektový. T ú t o podmienku dokážeme 
zosilniť tak, že z okolia skúmaného pixelu Navyše vyberieme pixely, od k torých budeme 
vyžadovať, aby boli pixelmi pozadia. T á t o operácia je nazývaná hit-or-miss t ransformácia 
a je zák ladným prostriedkom na rozpoznávanie vzorov v b i n á r n o m obraze. 

D e f i n í c i a | 2.5.71 (Hit-or-miss t ransformácia) . Nech A, B1, B2 C Z , B1f]B2 = 0. Mno
žinu 

A(DB :=(AeBl)n(AceB2), 

kde Ac značí komplement množiny A, nazveme hit-or-miss transformáciou množiny A 
(zloženým) š t r u k t ú r n y m elementom B = (Bi,B2). 

Zložené š t r uk tú rne elementy budeme značiť v tvare mriežky 2.6, pr ičom na pozíciu 
bjtk zapíšeme symbol „ 1 " , ak (j, k) G B1, symbol „0" , ak (j, k) G B2 a symbol „ x " , ak 
(j, k) G" B\ U B2. Pomocou hit-or-miss t ransformácie teraz dokážeme definovať operáciu 
s tenčenia a sekvenčného stenčenia. 

0 0 1 0 0 0 0 0 0 0 0 0 0 0 

0 1 1 0 1 1 0 0 1 0 0 1 0 0 

1 1 0 0 1 1 0 0 0 0 0 0 0 0 

1 1 1 1 1 1 1 0 0 0 0 0 0 0 

1 1 1 1 1 1 1 0 0 0 0 0 0 0 

Obr. 2.11: Hit-or-miss t ransformácia š t r u k t ú r n y m elementom B8 (vzťahy 2.8) 

D e f i n í c i a | 2.5.8 | (Stenčenie) . Nech A, B1,B2C Z 2 , B1nB2 = 0. Množinu 

A <g> B := A \ (A O B) 

nazveme s tenčením množiny A (zloženým) š t r u k t ú r n y m elementom B = (Bi,B2) 

D e f i n í c i a 2.5.9 (Sekvenčné stenčenie) . Nech A C Z 2 a nech {Bk}^=1, kde n G N , je 
postupnosť zložených š t ruk tú rnych elementov Bk = {B\,Bk), Bk,Bk C Z 2 . Množinu 

A ® {Bk}n

k=1 : = ((• • • ((A ® B1) ® B2 B' 

nazveme sekvenčným stenčením množiny A pos tupnosťou (zložených) š t ruk tú rnych ele
mentov B1 Bn. 
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P r i sekvenčnom stenčení je obvykle používaná nasledujúca pos tupnosť š t ruk tú rnych 
elementov pozostávajúca z B1, B2 a, ich troch rotáci í o 90°, 180° a 270° okolo poč ia tku . 

"0 0 0" x 0 0" "1 x 0" x 1 x 
B' = x 1 x , B2 = 1 1 0 , 5 3 = 1 1 0 1 1 0 

1 1 1_ x 1 x 1 x 0_ x 0 0_ 

"1 1 1" "x 1 x" "0 x 1" "0 0 x 
B5 = x 1 x 0 1 1 , 5 7 = 0 1 1 , B8 = 0 1 1 

0 0 0_ 0 0 x 0 x 1 x 1 x 

(2.8) 

Sekvenčné stenčenie je opakované i teračne až do stavu idempotencie, t. j . do vtedy, kým 
sa v obraze nenachádza žiaden zo vzorov 2.8. Výsledkom je obraz pozostávajúci z čiar 
širokých 1 pixel zachovávajúci súvislosť komponent. 

Obr. 2.12: Pôvodný obraz a jeho sekvenčné stenčenie 

2.5.4 G e o d e t i c k á d i l a t á c i a 

Operác ia dilatácie bola v sekcii 2.5.1 bola zavedená ako zjednotenie posunu t í vstupnej 
množiny, k toré sú určené š t r u k t ú r n y m elementom. Niektoré si tuácie si môžu vyžadovať 
výslednú množinu obmedziť tak, aby výsledkom nebolo celé zjednotenie, ale len jeho 
v h o d n á podmnož ina . 

D e f i n í c i a 2.5.10 (Geodet ická di la tácia) . Nech B, X C Z 2 , a nech A C X Množinu 

A ®x B := (A © B) n X 

nazveme geodetickou dilatáciou množiny A š t r u k t ú r n y m elementom B s maskou X. 

Maska X tak pôsobí ako obmedzenie šírenia dilatácie - vymedzuje body, o k toré môže 
byť množ ina A rozšírená. Okrem predpokladu A C X, k to rý m á pri aplikácii v obraze 
podobu 

i(j,k) <ix(j,k) pre j = l,...,h, k = l,...,w, 

ďalej vyžadujeme, aby vs tupný obraz i a maskovací obraz %x mali to tožné rozmery, resp. 
definičný obor. 
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2.6 Flood fill 

D e f i n í c i a 2.6.1 (Flood fill). Nech %\ : M —>• {0,1} je b inárny obraz, MQ ^ 0 množ ina 
jeho objektových pixelov, M b ^ 0 množ ina pixelov pozadia, p G M b a n , m G N . Ďalej 
nech 

MB={jKk 

k=l 

kde Ki, ... Kn sú 77-komponenty množiny M B . Operác ia /žooc? /z// je zobrazenie 

(ň,p) !-)• l 2 , 

p r ičom obraz z 2 je b iná rny obraz s definičný oborom M splňujúci 

1, ak g G -ří, 

i i (g) inak. 

kde K G {Ki, . . . , _ŕr n} je t á 77-komponenta množiny M b , k to rá obsahuje p. 

O _ o 

o o 

o _ o 

o o 
Obr. 2.14: Obraz a jeho úprava operáciou flood fill kde r] = r}± a p je jeho s t redový pixel. 
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Operác ia flood fill tak upravuje b iná rny obraz rozšírením jeho množiny objektových 
pixelov vs tupného obrazu o tie body, k toré patria do jednej zvolenej komponenty jeho 
množiny pixelov pozadia. Všeobecne býva definovaná pre ľubovoľný (nie nevyhnutne bi
nárny) obraz a pre ľubovoľný poč ia točný pixel. N a účely práce je však uvedená definícia 
postačujúca. Implementác ia je realizovateľná rekurz ívnym algoritmom [10] 

A l g o r i t m u s 1: F lood fill (pre rj = rjs) 

v s t u p n é d a t a : p = (j, k) 

i i f i{p) — 0 t h e n 

2 Nastav i (p) := 1 
3 Vykonaj F lood fill s p = (j + l,fc) 
4 Vykonaj F lood fill s p = (j,k + l) 

5 Vykonaj F lood fill s p = (j-l,k) 

6 Vykonaj F lood fill s p = (j, k - 1) 

7 Vykonaj F lood fill s p = (j + l,k + l 

8 Vykonaj F lood fill s p = (j + l , k - l 

9 Vykonaj F lood fill s p = (j-l,k + l 

10 Vykonaj F lood fill s p = (j - 1, Ä; - 1 

í i e n d 

2.7 Houghova t ransformácia 

Houghova t ransformácia je numer ická m e t ó d a na rozpoznávanie priamok, kružníc a iných 
matematicky vyjádři te lných kriviek v b i n á r n o m obraze. S ohľadom na ciele práce sa v 
nasledujúcom opise zameriame na priamky 

y = ax + b. 

A b y sme však zohľadnili aj priamky kolmé na os x, budeme používať normálový tvar 

g = x cos 9 + 2/sin#, (2.9) 

kde Q je kolmá vzdialenosť priamky od poč ia tku a 9 je uhol, k to rý zviera t á t o kolmica 
s osou x. Množina všetkých priamok v obraze tvor í dvoj pa rame t r i ckú sús tavu. A k obme
dzíme 9 na interval [0,7r), priamka je určená práve j e d n ý m bodom (0O, ŕ?o) v parametric
kom priestore. Potom kolineárne body v rovine (x, y) zodpovedajú sústave sinusiodálných 
kriviek s práve j e d n ý m priesečníkom (0O, g0), k to rý t ú t o priamku určuje. 
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y 

Q / \ (Za, 2/2) 

/ 3 \ 

Q = x 1 cos(0) + ^i_sin(9) 

g = :r 2 cos(9) + ? /2 S M (Q) 

0 

Obr. 2.15: Dva body určujúce priamku v rovine (x, y) a odpovedajúce sinusoidy 
určujúce parametre tejto priamky v parametrickom priestore. 

P r i detekcii priamok v obraze i s rozmermi hxw pristupujeme k numer ickému riešeniu. 
P r e m e n n é v rovnici 2.9 transformujeme tak, aby zodpovedali orientácii osí a súradnic iam 
pixelov obrazu 

j = -y, k = x g = k cos 9 — j sin 9. 

Rovinu g, 9 obmedz íme na obdĺžnik R x T, kde 

R= [0,-Vw2 + h2}, T = [ 0 , 7 r ) 

a kvantujeme delením 

1 
0 = ro < 7*1 < r 2 < • • • < r „ = -Vw2 + h2, 

0 = t0 < tx < t 2 < • • • < tm = TT, 

n, m E N, 

pr ičom z každého podintervalu zvolíme jednu reprezen ta t ívnu hodnotu 

Ql, Q2, • • • , Qn; 

ť? l , #2) • • • 5 ^ m -

Ďalej zavedieme n x m akumulačnú maticu A = [apq], k to rá je na zač ia tku v ý p o č t u 
nulová. V každom kroku numerického riešenia potom s k ú m a m e objektový pixel (j, k) 
obrazu a hodnotu apq matice A zvýšime o 1, ak 

{(9, &) I Q — k cos 9 — j sin 9} H [ r p _ i , rp] x [ í 9 _ i , ŕ,] ^ 0 , 
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t. j . ak sinusoida d a n á s k ú m a n ý m pixelom prechádza zodpovedajúcou bunkou mriežky 
získanej delením paramet r ického priestoru. 

Postup opakujeme pre vše tky objektové pixely skúmaného obrazu. Reprezen ta t ívne 
hodnoty gp,9q podintervalov [ r p _ i , rp], [tq-i, tq] prislúchajúce maximálnym prvkom apq 

matice A potom aproximujú parametre g a, 6 priamok nachádzajúcich sa v obraze - koli-
neárne body v obraze to t iž spôsobujú opakovanú inkrementác iu zodpovedajúceho prvku 
v akumulačnej matici A . 

/ Q = 
ä ( G ) - j s i n (f ) 

tq-l lq 

Obr. 2.16: Sínusoida v parametrickom priestore a jeho delenie mriežkou. 

Výpoče tná náročnos t Houghovej t ransformácie n a r a s t á s p o č t o m parametrov potreb
ných na určenie detekovaného objektu. Pre p r ípad priamok je však výpočet re la t ívne 
nenáročný a implementác ia je realizovateľná nas ledujúcim algoritmom 

A l g o r i t m u s 2: Houghova t ransformácia 

v s t u p : B iná rny obraz i o rozmeroch h x w 

v ý s t u p : Obraz h o rozmeroch \/h2 + w2 x 180 

1 Inicializuj obraz h = 0 

2 for each objektový pixel p(j, k) obrazu i do 

for 9 := 0 t o 180 do 

p := k cos(# • t t /180) - j sm(6 • t t /180) 

r := Round (p) 

h{r,9) := h{r,9) + 1 

e n d 

8 e n d 
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Obr. 2.17: Obraz obsahujúci jeden objektový pixel (vľavo) a zodpovedajúca sinusoida v 
parametrickom priestore (vpravo). 

-150 -

-100 -

150 -

-80 -60 -40 -20 0 20 40 60 80 
(I 

Obr. 2.18: Obraz obsahujúci dva objektové pixely (vľavo) a zodpovedajúce sinusoidy v pa
rametrickom priestore (vpravo). Priesečník tých to kriviek určuje parametre priamky danej 
bodmi v pôvodnom obraze. 
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3 Predspracovanie obrazových dát 
V nasledujúcej kapitole bude opísaný postup predspracovania obrazových dá t - skúma
nými obrazmi sú šedotónové snímky z mikroskopu zachytávajúce v lákna morských rias. 
Tieto v lákna sa všeobecne môžu na rôznych miestach v obraze prekrýať a krížiť. Cielom je 
d á t a pripraviť tak, aby bolo možné jednot l ivé v lákna separovať a nás ledne analyzovať ich 
vlastnosti. Konkré tne nás zauj íma ich dĺžka - aby sme j u boli schopní odhadnúť , každé 
v lákno potrebujeme reprezentovať jednou 8-konektívnou krivkou h r ú b k y 1 pixel. 

Prezentovaný postup predspracovania sa opiera o poznatky z publikácie [15] a za cieľ si 
pok ladá surové d á t a na požadovaný tvar previesť použ i t ím m e t ó d uvedených v kapitole 2. 
Demonš t rovaný bude na vybraných snímkach - prehľad všetkých spracovávaných snímok 
sa nachádza v prílohe A . 

Spracovávané snímky pochádza jú z digitálnej kamery, a sú tak do určitej miery ovplyvnené 
šumom. Tento šum spôsobuje zrnitosť, k to rá sa môže pri prahovaní a následných mor
fologických úpravách patologicky prejaviť v podobe malých novovzniknutých segmentov 
vlákien nevyskytujúcich sa v pôvodnom obraze. 

Obr. 3.3: Snímka 1 (detail) pred filtráciou, po aplikácii mediánového filtra a po 
aplikácii filtra klzavého priemeru. 

Obr. 3.1: Snímka 1 Obr. 3.2: Snímka 1 (detail) 

3.1 Fi l t rácia 
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N a pot lačenie impulzného šumu je použi tý 3 x 3 mediánový filter nasledovaný 3 x 3 
l ineárnym filtrom klzavého priemeru 

1 1 1 
G = - 1 1 1 , 

U 1 !_ 

k torý v obraze ďalej pot lačuje adi t ívny šum. 

3.2 Segmentácia 
Pozorované objekty pozostávajú z pixelov, k toré ma jú v porovnan í s pozad ím značne 
nižšie jasové hodnoty. Snímky sú preto dobre segmentovateľné prahovaním. 

Vo väčšine pr ípadov je možné p rahovú hodnotu spoľahlivo stanoviť v izuá lnym posúde
n ím histogramu. Kvôli nerovnoměrnos t i osvetlenia v snímke zpôsobenej n a j m ä vinetáciou 
však uprednos tňu jeme adap t ívny p r í s tup . Adap t ivně prahovanie n á m navyše dovoľuje pro
ces automat izovať up l a tnen ím iteračnej m e t ó d y stanovenia op t imá lneho prahu uvedenej 
v časti 2.4, k to rá by pri klasickom prahovaní neposkytovala vhodný výsledok (obr 3.4a). 
Obrazy sú tak rozdelené pravidelnou mriežkou na časti p rahované samostatne. 

(c) (d) 

Obr. 3.4: (a) prahovanie g lobálnym prahom získaným i te račným výpoč tom, (b) 
manuá lnou voľbou prahu, (c) adap t ivně prahovanie s i t e račným v ý p o č t o m prahu 
a (d) adap t ivně prahovanie s i t e račným v ý p o č t o m prahu a ods t r ánen ím oblast í 
s nepos tačujúc im rozptylom (snímka 1). 
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Nakoľko je prahová hodnota vypoč í t avaná lokálne a pre každú časť obrazu samostatne, 
dochádza k nežiadúcej segmentáci í oblast í , v k torých sa pozorované objekty nenachádza jú 
(obrázok 3.4c). Tento jav je napravený s tanovením podmienky min imálneho rozptylu ja
sových hodnô t . P r i použi t í mriežky n x m deliacej definičný obor obrazu 

i : { l , . . . , / i } x { l , . . . , « ; } - > { ( ) , . . . , 2 5 5 } 

na podmnož iny 

D n = { l , . . . , / i i } x { l , . . . , ^ } , 

D2i = {h + 1 , . . . , h2} x { 1 , . . . , Wi}, 

Dnm = {K-i + 1 , . . . , hn} x { w m _ i + 1 , . . . , wm}, 

kde 0 = ho < h\ < h2 < • • • < hn = h a 0 = wo < w\ < w2 < • • • < wm = w, sú 
vypoč í t ané hodnoty rozptylu 

1 2 1 
v a r D n m = — - — r (i(p) - Hnm) , kde [inm = — — r i{p). 

\L>nm \ p(zDnm \U" 

a hodnota pr iemerného rozptylu 

1 n m 

3=1 k=l 

Pixe l p G Dnm obrazu i je následne vyhodno tený ako objektový vtedy, ak vyhovuje 
predpisu 2.4 a oblasť Dnm zároveň splňuje podmienku 

var Dnm > e<7mm, 

kde e > 0 je vhodne zvolená reá lna konš t an t a citlivosti. 

3.3 Morfologická rekonštrukcia 

Prahovan ím bol získaný b iná rny obraz rozlišujúci objekty - v lákna - od pozadia. Nakoľko 
hranica vlákien m á na snímkach pozorovatelne nižšiu jasovú hodnotu ako ich vnú t ro , pr i 
prahovaní dochádza k chybnému vyhodnoteniu v n ú t r a vlákien ako súčast i pozadia na 
miestach, kde je tento rozdiel dos ta točne veľký (obrázok 3.5a). 

Vzniknuté diery v objektoch je možné vyplniť opakovanou di latáciou a eróziou. Tento 
postup je však aplikovateľný len v pr ípade , že sa na snímke nenachádza jú miesta, v k torých 
sú dve v lákna blízko seba - di la tácia spôsobí ich umelé spojenie (obrázok 3.5b). A b y 
sme javu predišli , použ i t á je geodet ická di la tácia opísaná v časti 2.5.4 (obrázok 3.5d). 
Maskovací obraz ix (obr 3.5c) je zostrojený nasledujúcim spôsobom: 

(i) Z obrazu získaného p rahovn ím sú ods t r ánené komponenty množiny objektových 
pixelov, k toré obsahujú okrajové pixely 1 . 

1 P i x e l p = (j, k), ktorý m á aspoň j e d n u súradnicu rovnú jednej, alebo maximálnu. 
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(ii) Zvolený je ľubovoľný okrajový pixel p = (j, k). 

(iii) Vykonaná je operácia flood fill s poč i a točným pixelom p. 

(iv) Z obrazu z predchádzajúceho kroku je vytvorený obraz komplementárny . 

(a) (b) (c) 

Obr. 3.5: (a) detail sn ímky 2 po prahovaní , (b) spojenie vlákien po dilatácii , (c) 
maskovací obraz, (d) geodet ická di latácia . 

Takto získaný maskovací obraz je b iná rnym obrazom, v ktorom objektové pixely tvoria 
tie komponenty množiny pixelov pozadia v s tupného obrazu, k toré neobsahujú jeho okra
jové body. Indikuje tak práve diery, k toré ma jú byť vyplnené, a p r ípadné komponenty 
spôsobené kr ížením vlákien. Tieto komponenty sú ods t ran i te lné opakovaním kroku (ii) 
s vhodnou voľbou p. V skúmaných snímkach to však nebolo nu tné . Pre výs tupný obraz 
%2 tak pla t í 

kip) ÍM = 1 A ixip) 

kde z® je obraz získaný klasickou di latáciou vs tupného obrazu i\, t. j . množ ina objektových 
pixelov M Q výs tupného obrazu i2 je d a n á 

Ml = {M}, ®x B) = (Ml ®B)n MQ, 

kde -B je š t r u k t ú r n y element 

B 
1 1 ľ 
1 1 1 
1 1 1 

(3.1) 

Geodet ická di la tácia je opakovaná do stavu idempotencie, t. j . p o k ý m ďalšie jej opakovanie 
už obraz nezmení . 

3.4 Stenčovanie a čistenie 

Morfologicky rekonšt ruovaný obraz je nás ledne s tenčovaný postupom opísaným v časti 2.5.3 
Stenčovanie je uprednos tnené pred eróziou, nakoľko vyžadujeme zachovanie súvislosti 
komponent obrazu. Výsledkom je skelet objektov v obraze. S výnimkou miest, kde dochá
dza k p re t ínan iu sa vlákien, ma jú vše tky objektové pixely obrazu nana jvýš dva objektové 
8-susedné pixely. 
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V obraze sa však stále nachádza jú nežiadúce objekty. Vlákna , k to ré nie sú na snímke 
zachytené celé, nie je možné z hľadiska ich dĺžky j e d n o d u c h ý m spôsobom analyzovať. Za 
predpokladu, že tieto neúplné segmenty preds tavujú menej ako 5% obrazových dá t , ich je 
možné z obrazu odstrániť bez toho, aby bola znehodno tená š ta t i s t ická in terpre tác ia získa
ných výsledkov. V opačnom pr ípade je ich n u t n é pri š ta t i s t ickom spracovaní považovať za 
cenzorované dá t a . Nakoľko však predmetom práce nie je š ta t i s t ická analýza, ale separácia 
pret ínajúcich sa kriviek, neúplné v lákna sú z obrazu vždy ods t ránené . 

Obr. 3.6: Obraz po stenčení (vľavo) a po ods t r ánen í okrajových objektov (vpravo) 

Z obrazu sú následne ods t r ánené aj osamotené pixely, t. j . objektové pixely, k toré 
nemajú ani jeden 8-susedný pixel, k to rý by bol tiež objektový. Ods t ránen ie je vykonané 
operáciou uzavretia so š t r u k t ú r n y m elementom 3.1. 
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4 Analýza pretínajúcich sa objektov 
V nas ledujúcom texte p reds tav íme algoritmus, k to rý realizuje separovanie kriviek v obraze 
z ískanom postup z predchádzajúcej kapitoly. Začínajúc v jednom z ich koncových bodov 
v obraze postupujeme pixel po pixely, zaznamenávajúc každý bod kr ivky do nového vý
s tupného obrazu. V miestach, kde sa kr ivky krížia, spájajú alebo rozdeľujú, je n u t n é 
vykonať rozhodnutie o ich náväznost i . Voľba nasledujúceho pixelu trasovanej kr ivky je 
p r imárne založená na porovnan í sklonu 9 priamok, k toré j u lokálne aproximujú pred a za 
miestom kríženia. V miestach, kde sa jedna kr ivka rozdeľuje na dve je Navyše využi tá 
informácia o jej minulom chovaní - zohľadnený je predchádzajúci sklon # o l d a predchádza
júci smer d o l d . Nakoniec bude opísaná me tóda , ktorou budeme dĺžku separovaných kriviek 
odhadovať. 

4.1 Trasovanie 

Vstupný b iná rny obraz získaný procesom predspracovania op ísanom v predchádzaj úej 
kapitole označme 

i : M -)• {0,1} (4.1) 

a ďalej zaveďme: 

(i) obraz koncových bodov e : M —>• {0,1} daný 

(ii) obraz priesečníkov x : M —>• {0,1} daný 

1 ak i (p) 

(iii) obraz oblúkov a : M —>• {0,1} daný 

a(p) = i(p) — x (p) 

(iv) rozšírený obraz koncových bodov e* : M —>• {0,1} daný 

(v) obraz bodov spojenia s : M —>• {0,1} daný 

s (p) = e* (p) - e(p) 
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kde Oi(p) je množ ina 8-susedných objektových pixelov pixelu p obrazu i zavedená v čast i 2.1. 
Obrazy (i), (iii) a (v) zostrojené z predspracovanej sn ímky 1 sú zobrazené na obrázkoch 4.1, 
4.2 a 4.3. 

[ 

í \ 
^^^^^ 

1 
Obr. 4.1: Obraz oblúkov a (vľavo) a jeho detail (vpravo). 

Obr. 4.2: Obraz koncových bodov e (vľavo) a jeho detail (vpravo). 

Obr. 4.3: Obraz bodov spojenia s (vľavo) a jeho detail (vpravo). 
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Poznamenajme, že vyššie uvedené obrazy sú korektne definované. Rozdiel v predpise 
obrazu oblúkov a (iii) je nulový alebo rovný jednej, nakoľko ak x{p) = 1, potom aj 
i (p) = 1 ako priamy následok predpisu obrazu x. Analogicky argument p la t í pre obraz 
bodov spojenia s. Nakoniec označme E, X, A, S množiny objektových pixelov obrazov 
6. X y (X y S • 

Algoritmus trasovania je cyklický a po
zostáva z niekoľkých procedúr . Vstupom 
je b iná rny obraz 4.1. Vytvorený je vý
s tupný b inárny obraz o : M —y {0,1} 
daný 

°ip) = 0 pre vše tky p E M 

a zvolený je poč ia točný bod p G E. 
Následne je volaná p rocedúra T r a s o v a ť 
(obr 4.10), k to rá „posúva" bod p po ak
tuá lne trasovanej krivke v obraze a. Po 
každom novom zvolení bodu p je tento 
bod p r idaný do množiny objektových pi
xelov výs tupného obrazu o, t. j . 

o{p) -G- 1. 

P r o c e d ú r a T r a s o v a ť je volaná opako
vane do vtedy, k ý m bod p nie je kon
covým bodom krivky. Tento proces je 
opakovaný pre každý poč ia točný bod 
z množiny E. V ý s t u p o m je potom sek-
vencia obrazov o, z k torých každý obsa
huje práve jednu digi tálnu kr ivku repre
zentujúcu jedno z vlákien rias z pôvodnej 
snímky. 

S a m o t n á p rocedúra T r a s o v a ť (obrázok 4.10) pozostáva z dvoch častí . V prvej časti 
(obrázok 4.10, kroky 6-9) sú t rasované kr ivky v obraze oblúkov a - na základe ak tuá lneho 
pixelu p je volený pixel nasledujúci , k to rý je vzhľadom k nemu vždy 8-susedný. Nakoľko 
pre množinu A objektových pixelov obrazu a p la t í 

í<\Oa(p)\<2 pre vše tky p G A, 

nasledujúci pixel je vždy určený jednoznačne ako t aké q G Oa(p), k toré nebolo vyhod
nocované v minulom kroku (obrázok 4.4). V druhej časti (obrázok 4.10, kroky 12-14) je 
volaná p rocedúra R o z h o d n i , k to rá rieši rozhodovanie v miestach spájania, rozchádzania 
sa alebo kríženia sa vlákien. Tieto miesta sú detekované ako body, k toré ma jú iba jeden 
8-susedný pixel objektový v obraze a a zároveň nie sú objektové v obraze koncových bodov 
e. 

Štart 

N a s t a v p, p0i<j ľubovoľný 

(ten istý) b o d z E 

Získaj n o v ý b o d p 
procedúrou T r a s o v a ť 

N i e 

Á n o 

r 

(^ K o n i e c J 
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Oa(p) 

\ 

m 
Oa(p) 

F o l d P 

P = Polá P o l d 

Obr. 4.4: Výber nasledujúceho pixelu v krokoch 6-9 p rocedúry T r a s o v a ť 

Kríženie vlákien v snímke sa v predspracovanom b i n á r n o m obraze i prejavuje dvomi 
spôsobmi - dochádza k dvom rôznym vzorom, k toré budeme nazývať x-priesečník a y-
priesečník. V prvom pr ípade je miesto kríženia charakter izované lokálnou pr í tomnosťou 
4 bodov spojenia, zatiaľ čo v druhom pr ípade sú lokálne p r í tomné len 3. P r i m á r n e , x-
priesečníky vznikajú v miestach, kde sa prekrývajúce v lákna rozchádzajú. Okrem toho 
však nás ledkom stenčovania v čast i 3.4 degenerujú na x-priesečníky aj miesta, kde sa 
v lákna pre t ína jú pod dos ta točne o s t r ý m uhlom. 

(a) (b) 

Obr. 4.5: (a) x-priesečník, (b) y-priesečník 

P r o c e d ú r a R o z h o d n i m á dve varianty. V pr ípade , že nepoznáme informáciu o pred
chádzajúcom správaní sa kr ivky alebo pri prechode algoritmu x-priesečníkom je nasledu
júci pixel volený na základe sklonu 9 priamky, k to rá aproximuje segment vhodnej dĺžky 
kr ivky do priesečníku vs tupujúcej . Tento sklon je porovnávaný so sklonom odpoveda
júc im segmentom v ý s t u p n ý m a preferovaný je ten segment, k to rý minimalizuje vhodne 
definovanú vzdialenosť sklonov. 

/ 
1 

(a) (b) (c) (d) 

Obr. 4.6: (d) detail obrazu oblúkov a sn ímky 1, (a) v s tupný segment, (b) p rvý výs tupný 
segment, (c) d ruhý výs tupný segment 
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Vyššie spomenu tý sklon je získaný Houghovou t ransformáciou opísanou v časti 2.7. 
V obrazoch 4.6a-4.6c sú detekované priamky 

g = x cos 9 + ysm9, (4.2) 

k torých parametre sú aproximované priesečníkom v sinusoidálnych kriviek v parametric
kom priestore na obrázkoch 4.7a-4.7c. 

-80 -60 -40 -20 0 20 40 60 80 

e 

(c) 

Obr. 4.7: Výsledok Houghovej t ransformácie (a) segmentu 4.6a, (b) segmentu 4.6b, (c) 
segmentu 4.6c. Počet priesečníkov môže byť všeobecne väčší ako 1. V tom pr ípade je 
hodnota parametru 9 odč í t aná ako hodnota ich geometr ického stredu, t. j . a r i tmet ického 
priemeru ich súradníc . 
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Tieto priamky považujeme za lokálnu aproximáciu odpovedajúcich segmentov krivky. 
Z Houghovej t ransformácie však n e m á m e informáciu o smere a veľkosť uhla 9 n a d o b ú d a 
len hodnoty z intervalu dĺžky TV. P r i porovnávaní veľkosti uhlov je tak n u t n ý modu lá rny 
pr í s tup . Uvažovať budeme 9 G [0, n). 

Obr. 4.8: Rozdiel sklonu priamok 

Označme 9\ sklon odpovedajúci v s t u p n é m u a 92, 93 v ý s t u p n ý m segmentom krivky. Ako 
je vidieť na obrázku 4.8, kde 92 > #i, požadovaná hodnota vzdialenosti nemôže byť ipg, 
ale QQ. Vypoč í tané sú preto hodnoty Qe(9i,92), QoiOiiOz), kde 

Qo(a, b) := min{|6 — a\, n — \b — a\}. (4.3) 

Poznamenajme, že takto definované QQ je metrikou. Následne je zvolený nasledujúci pixel 
p tak, aby p patrilo fc-temu v ý s t u p n é m u segmentu krivky, k to rý je zvolený tak, aby pre 
odpovedajúci sklon 9k platilo 

0 fc = argmin f c g(91,9k), kde k>2. (4.4) 

Po prechode priesečníkom je hodnota 9\ je uložená do premennej 9Q\&. T á t o hodnota je 
zohľadňovaná druhou variantou proceduri R o z h o d n i , k to rá je volaná vtedy, ak algoritmus 
vyhodnocuje y-priesečníky (a 9Q\& existuje). Postup je analogický ako v p r ípade varianty 
prvej s t ý m rozdielom, že za vs tupný sklon je považovaná práve hodnota # 0 i d -

(a) (b) (c) (d) (e) 

Obr. 4.9: (a) vzor spôsobujúci zacyklenie, (b), (c), (d), (e) segmenty kr ivky 
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V urči tých pr ípadoch môže t rasovaná kr ivka vytvárať vzory, k toré vedú na zacyk
leme algoritmu. K tomuto javu dochádza napr ík lad v p r ípade vyzobrazenom na ob
rázku 4.9a. P r i t rasovaní začínajúc ľavým okrajovým pixelom obrazu je po prechode 
p r v ý m y-priesečníkom uložená hodnota 60\d (segment na obrázku 4.9b), k to rá je však 
takmer t o tožná so sklonom pravej polovice segmentu na obrázku 4.9d a pri prechode 
d r u h ý m y-priesečníkom teda vyhovuje vzťahu 4.4. 

N i e 

S ta r t 

N a s t a v k <— 0 

N a s t a v o(p) <— 1, 

Ptemp <- P, v y t v o r Oa(p) 

N a s t a v p <— q, kde 

Q e Oa(p), q í Pold 

N a s t a v k 

Pold <-
<- k + 1, 

Ptemp 
Á n o 

11 

13 

14 

— • 

Á n o 

N a s t a v 0o\d *~ bez h o d n o t y 

N i e 

Z í ska j n o v ý b o d p 
p r o c e d ú r o u Rozhodni 

N a s t a v p0\d <— p, 
o(p) « - 1, 

( K o n i e c 

N i e 

Obr. 4.10: P r o c e d ú r a T r a s o v a ť 

A b y sme zacykleniu predišli, s tanovená je podmienka dominatného smeru. Vyhodno
cované segmenty sú kr ivky 

P!,...,pn, kde Pk = (pk,Pk)i P r e k = l , . . . , n . (4.5) 
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Nakoľko však postupnosti pí: ... ,pn a pn, ... ,pí: definujú t ú is tú kr ivku, bod p\ je kvôli 
j ednoznačnos t i vždy volený ako p rvý t rasovaný pixel daného segmentu. Zostrojený je 
smerový vektor 

V = Pn ~ Pl = {Pn ~ p\, PÍ ~ P\) = ( V , V2). (4.6) 

pre každý z uvažovaných segmentov a d o m i n a t n ý smer 

d := a r g m a x f c e { 1 2 } vk. (4.7) 

pre segment vs tupujúci . P r i prechode priesečníkom potom vyžadujeme, aby rj-ta zložka 
vs tupujúceho a vys tupujúceho smerového vektoru v mal i rovnaké znamienko. Tento po
stup zacykleniu zabráni l vo všetkých spracovávaných snímkach. 

Obr. 4.11: Snímka A (vľavo) a výsledná separovaná kr ivka vo v ý s t u p n o m obraze o (vpravo) 

V kroku 17 algoritmu R o z h o d n i (obrázok 4.12) je volený nasledujúci bod p z množiny 
S (p), k to rú definujeme 

S(p):={qeS:qeOe(p)} ( 4-8) 

pre vhodne zvolené e G M + . Množina S (p) je teda tvorená bodmi spojenia, k to ré sa nachá
dzajú v okolí pixelu p. Okrem vyššie uvedených kritérií , na základe k torých je vykonávané 
rozhodovanie v miestach priesečníkov, je Navyše zohľadnená informácia o tom, či seg
ment, po ktorom sa m á algoritmus vydať, už p a t r í niektorej z kriviek separovaných v jeho 
predchádzajúcich cykloch, t. j . či pre n iek torý z výs tupných obrazov o p la t í 

o(q) = 1. (4.9) 

P r i voľbe p sú preferované také body, k toré ešte žiadnej separovanej kr ivky nepatria. 
A k t aké to body neexistujú, podmienka je ignorovaná a nový bod p je volený z celej 
množiny S (p). 

37 



15 

N a s t a v o(p) <— 1, 
Zos t ro j m n o ž i n u S (p) 

16 

17 

^ ^ ^ J e = 3 a 

^ ^ ^ ^ ^ existuje 0 o l d ? ^ ^ ^ ^ 

Á n o N i e 

Z í s k a j n o v ý b o d p 6 S(p) 
n a z á k l a d e h o d n o t y #0id 

Získa j n o v ý b o d p £ S (p) 
n a z á k l a d e h o d n o t y ô 

Obr. 4.12: P r o c e d ú r a R o z h o d n i . 

Nakoľko trasovanie je vykonávané na pixeloch obrazu oblúkov a, k to rý neobsahuje 
body priesečníkov, výsledný obraz o tieto body neobsahuje tiež. Tieto „medzery" (obrá
zok 4.13a) sú prepojené opakovaním operácií di latácie (obrázok 4.13b) a s tenčenia (obrá
zok 4.13c), čím zároveň dochádza k miernemu vyhladeniu výslednej krivky. 

(a) (b) (c) 

Obr. 4.13: (a) detail výs tupného obrazu o, (b) po dilatácii a (c) po nás lednom stenčení 

> 

4.2 Est imácia dĺžky 
Množina objektových pixelov M Q výs tupného obrazu určuje všeobecne viac ako jednu 
kr ivku podľa definície 2.1.4. A k však vyslovíme ľahko pochopiteľný predpoklad, že poža
dovaná kr ivka je j ednoduchá a m á dĺžku n = \ M Q \ , potom je (až na zámenu poradia jej 
prvkov) u rčená jednoznačne . Označme t ú t o kr ivku 

C=(p0,...,pn). (4.10) 

Následkom stenčovania v časti 3.4 t á t o kr ivka podhodnocuje sku točnú dĺžku riasového 
v lákna - v lákno je s tenčované rovnomerne po svojom obvode, a jeho pôvodné koncové 
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body sú tak posunu té . K r i v k u C preto na oboch koncoch predĺžime o m bodov, pr ičom 
m je najväčšie pr i rodzené číslo splňujúce 

(({po,Pn}®B)...®B) <ZM'0, (4.11) 

m-krát 

kde M'0 je množ ina objektových pixelov obrazu získaného morfologickou rekonštrukciou 
v časti 3.3 a i? je š t r u k t ú r n y element 

B 
x 1 x 
1 1 1 
x 1 x 

(4.12) 

Množina koncových bodov {po,pn} k r ivky 4.10, k to rá je nás ledkom vlas tnos t í operácie 
s tenčovania podmnož inou množiny objektových pixelov M'Q morfologicky rekonštruova
ného obrazu, je teda opakovane di la tovaná do stavu, keď už podmnož inou M'Q nie je. Za
znamenaný je počet opakovaní m, k to rý je pri tom vykonaný. T ý m je z ískaná informácia 
o poč te krokov stenčovania, k toré bol i vykonané v rámci predspracovnia, pred dosiahnutím 
idempotencie v okolí koncových bodov vlákna. 

({p0}®B)®B 

Po 
Mo Mo 

(a) (b) 

Obr. 4.14: (a) Posunu tý koncový bod po k r ivky C a množ ina objektových pixelov M'Q 

obrazu získaného v časti 3.3, (b) 2-krát opakovaná di la tácia množiny {po}. 

Tieto body sú potom ku krivke C p r idané v smere danom rozdielom súradníc jej 
posledných dvoch bodov. Upravená kr ivka je potom; 

am, ..., ai, a0 = po, ... ,pn = b0, bi, ..., bm, (4.13) 

kde 

ao = Po, 

ak = ak-i + (po - Pi), 

b0=Pn, (4.14) 

bk = + {Pn -Pn-l), 
pre k — 1 , . . . , m. 

39 



a2 o! p0 

Obr. 4.15: Pred ĺžená kr ivka C. 

Přeznačme body takto predĺženej digitálnej kr ivky q 1 , . . . , q^. Mnohé známe metody 
est imácie dĺžky kriviek v dig i tá lnom obraze sú založené na ich interpolácií po lynómom 
alebo splajnom - pozorovaním však vidíme, že skúmané v lákna rias pozostávajú z rovných 
článkov a h l adká (analyt ická) kr ivka tak nevystihuje ich charakter. Navyše, k určitej 
miere vyhladenia došlo už pri predchádzajúcich operáciách dilatácie a stenčovania. Na 
odhad dĺžky je volená m e t ó d a upravu júca súradnice bodov ? i , . . . , ? j v kr ivky 4.13 váženým 
priemerom podľa predpisu 

qi ak k — 1, 

qN ak k = N. 

w{qk_l - qk) + qk + w(qk+1 - qk) 

(4.15) 

inak, 

kde w G [0,1] je váha. Za výsledný odhad í sa potom ukazuje byť vhodné [14] považovať 
sumu euklidovských vzdialeností 

i = aJ2 Q2(xk-i,xk) = « E v ( I l - x l - i ) + (xl 
k=l k=l 

kde a G M je konš t an t a zohľadňujúca mierku pôvodnej snímky. 

x k-l (4.16) 

N X2 
1>-

q4 

Obr. 4.16: Body xk upravujúce súradnice pixelov qk s váhou w = 0.5 podľa vzťahu 4.15. 
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5 Výsledky 
Postupom prezentovaným kapi to lách 3 a 4 bola pre každé separované vlákno v snímkach 
A , B , C a D vypoč í t aná 

(i) hodnota n vyjadrujúca dĺžku odpovedajúcej jednoduchej digitálnej kr ivky podľa 
definície 2.1.4, (t. j . počet pixelov kr ivky) , 

(ii) hodnota / vyjadrujúca odhad dĺžky tejto kr ivky podľa vzťahu 4.16 pri a = 1. 

Výsledné hodnoty sú uvedené v tabuľke 5.1. Samotné sn ímky a vybrané separované v lákna 
sa nachádza jú v prílohe A . 

Tabuľka 5.1: Výsledné hodnoty n a / vlákien rias v sn ímkach A , B , C a D . 

Snímka Vlákno n 1 

A I 100 106,03 
II 27 31,21 
III 128 141,72 
IV 1400 1643,55 
V 2578 2852,91 
V I 129 135,21 
VII 177 183,44 
VIII 48 55,1 

B I 837 991,05 
II 100 133,67 
III 45 53,70 
IV 22 21,24 

C I 39 39,18 
II 536 603,75 
III 472 536,99 
IV 2373 2704,90 
v 1417 1646,02 
V I 345 388,16 
VII 315 367,1 
VIII 179 206,27 

D I 349 369,56 
II 691 805,61 
III 1755 1979,46 
IV 605 652,17 
v 112 120,63 
V I 30 37,16 

Postupom predspracovania uvedenom v kapitole 3 a originálny algoritmom prezento
vaným v kapitole 4 boli zo snímok A , B , C a D úspešne separované požadované krivky. 
Vo všetkých z uvedených pr ípadov pracoval algoritmus spoľahlivo, replikujúc subjekt ívne 
vn ímanie náväznost i vlákien v pôvodných snímkach. Slabou s t ránkou algoritmu je jeho 
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výpočtová náročnosť a pož iadavky na operačnú pamäť zariadenia. A j keď s a m o t n á Houg-
hova t ransformácia ná ročná nie je, v priebehu algoritmu je vy tvá raný a uk ladaný veľký 
počet nových obrazov (obraz koncových bodov, obraz priesečníkov, ...). S ras túc imi roz
mermi vs tupného obrazu potom rýchlo n a r a s t á aj časová a výpočtová náročnosť algoritmu. 
Tomuto problému je však možno predísť - rozmery vs tupných obrazov je možné reduko
vať pre vzorkovaním. Za predpokladu, že t ý m t o prevzorkovaním nedochádza k narušen iu 
spojitosti objektov na snímke, sa výsledok algoritmu nezmení . 
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Záver 
P r á c a sa zaoberala problematikou separácie pret ínajúcich sa digi tálnych kriviek v binár
nom obraze. P reds tavený bol algoritmus vykonávajúci detekciu a separáciu týchto kriviek. 
Houghova t ransformácia , k to rá je nás t ro jom na detekciu priamok v obraze, bola v algo
ritme u p l a t n e n á novým spôsobom - na aproximáciu „sklonu" kr ivky v mieste jej kríženia 
sa s krivkou inou. 

P rezen tovaná bola metodika pr íp ravy konkré tnych obrazových dá t . Spracovávané boli 
sn ímky z mikroskopu zachytávajúce vlákni té sinice Nostoc, k toré sa v obraze na viace
rých miestach pre t ína jú . P ros t r edn íc tvom lineárnej filtrácie, segmentácie , morfologických 
operácií a numerických m e t ó d boli obrazové d á t a pr ipravené na spracovanie or iginálnym 
algoritmom. 

V kapitole 1 bol uvedený m a t e m a t i c k ý a p a r á t tvoriaci teoret ický základ m e t ó d a po
stupov, k toré boli v práci použi té . P rezen tovaná bola p r imárne teór ia z oblasti b inárnych 
relácií a metr ických priestorov. V kapitole 2 bol definovaný digi tálny obraz, jeho vlast
nosti a vybrané numerické metódy, k toré sú v práci použi té . V kapitole 3 bol opísaný 
konkré tny postup, a k ý m boli surové sn ímky upravené pred tým, než z nich boli separo
vané jednot l ivé kr ivky reprezentujúce v lákna sinic. V kapitole 4 bol preds tavený samotný 
algoritmus, k to rý vykonáva separáciu digi tálnych kriviek v b i n á r n o m obraze. Výsledky 
práce boli zh rnu t é v kapitole 5. 
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A Snímky 
N a nasledujúcich obrázkoch sú vyzobrazené snímky rias, k toré boli spracovávané, a vy
b rané vlákna, k toré boli zo snímok separované. 

Obr. A . l : Sn ímka A Obr. A . 2 : Snímka B 

Obr. A . 3 : Snímka A , v lákno I V Obr. A .4 : Snímka B , v lákno I 

Obr. A . 5 : Snímka A , v lákno I V Obr. A .6 : Snímka B , v lákno II 
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Obr. A .9 : Snímka C, v lákno II 

Obr. A . 11: Sn ímka C, v lákno I V 

Obr. A . 10: Snímka D , v lákno III 

J 

Obr. A . 12: Snímka D , v lákno I V 
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B Opis vytvoreného softvéru 
V rámci práce bol vytvorený v las tný softvér vo vývojovom pros t red í Delphi 7. Softvér je 
určený na spracovávanie obrazových dá t vo formáte 8-bitových . B M P súborov so šedotó-
novou paletou, pr ičom vykonáva vše tky operácie a m e t ó d y spracovania obrazu uvedené v 
kapi tolách 2, 3 a 4. 

Select image 

File 

A d d imagejs 

Process selected image 

Remove selected image(s) 

Exit 

Obr. B . l : Hlavné okno softvéru 

Obrazové súbory formátu . B M P , k toré ma jú byť upravované, je po t r ebné pridať do 
zoznamu súborov v hlavnom okno zvolením možnost i F i l e > Add image(s) . Pr idať je 
možné viacero súborov zároveň. 

JK Select image — D X 

File 

Obr. B.2: Okno s o tvoreným súborom 

Označen ím jedného zo súborov v zozname a nás ledným zvolením možnost i F i l e > 

P r o c e s s s e l e c t e d image sa otvorí nové okno s náhľadom otvoreného . B M P súboru a s 
ponukou nás t ro jov na jeho spracovávanie. 
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Možnosť 

- View > True s i z e zobrazí spracovávaný obraz v jeho skutočnej veľkosti. 

- View > F i t t o window pr ispôsobí rozmery spracovávaného obrazu a k t u á l n y m roz
merom okna. Obraz samotný nie je upravovaný, j e d n á sa len o jeho zobrazenie. 

- View > F i t t o window pr ispôsobí rozmery okna a k t u á l n y m rozmerom spracováva
ného obrazu. 

- Image > Save uk ladá ak tuá lny stav obrazu do nového, alebo pôvodného . B M P sú
boru. 

Nást ro je vykonávajúce numerické m e t ó d y spracovania obrazu sa nachádza jú v záložke 
Image. Možnosť 

- Image > Mean vyhladzuje obraz l ineárnym filtrom kĺzavého priemeru s konvolučným 
jadrom 3 x 3 . 

— Image > Medián vyhladzuje obraz med iánovým filtrom 3 x 3 . 

— Image > T h r e s h o l d vykonáva prahovanie obrazu. 

- Image > Erode resp. Image > D i l a t e vykonávajú eróziu, resp. di la táciu obrazu 
š t r u k t ú r n y m elementom 2.6. 

- Image > T h i n vykonáva jednu i teráciu sekvenčného s tenčenia pos tupnosťou š t ruk
tú rnych elementov 2.8. N a opakovanie s tenčovania je možné využiť klávesovú skratku 
CTRL + T. Stenčovanie je n u t n é zakončiť možnosťou Image > F i n i s h t h i n n i n g . 

- Image > Remove edge o b j e c t s ods t raňuje z obrazu objekty dotýkajúce sa jeho 
okrajov. 
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- Image > D i l a t e i n s i d e vykonáva geodet ickú di la táciu s maskou opísanou v časti 3.3. 
Pred geodetickou di latáciou je n u t n é odstrániť objekty dotýkajúce sa okrajov ob
razu. 

- Image > Remove s t r a y p i x e l s ods t raňuje osamotené objektové pixely využi t ím 
operácií otvorenia a uzavretia. 

- Image > Trace vykonáva separáciu kriviek v obraze. Pred použ i t ím možnost i Trace 

je nu tné , aby obraz obsahoval iba kr ivky široké 1 pixel a neobsahoval objekty do
týkajúce sa jeho okrajov. Separácia môže trvať niekoľko desiatok minú t a výsledné 
separované kr ivky sú uk ladané ako samos ta tné . B M P súbory do priečinku, v ktorom 
sa nachádza práve spracovávaný . B M P súbor . 

- Image > R e s t o r e e n d p o i n t s predlžuje separovanú kr ivku tak, aby jej dĺžka od
povedala dĺžke jej zodpovedajúceho objektu v pôvodnom obraze (vysvetlenie sa 
nachádza v časti 4.2). 

Záložka Analýze obsahuje jedinú možnosť C a l c u l a t e l e n g t h . vyčíslujúcu hodnoty n a / 
opísané v časti 4.2. N a výpočet tých to h o d n ô t je nu tné , aby otvorený obraz obsahoval iba 
jednu kr ivku širokú 1 pixel. Výsledky z kapitoly 5 je možné reprodukovať nasledujúcou 
pos tupnosťou operácií: 

(i) vyhladenie nás t ro jom Mean f i l t e r alebo Medián f i l t e r 

(ii) prahovanie nás t ro jom T h r e s h o l d , 

(iii) morfologická rekonštrukcia opakovaným použ i t ím nás t ro ja D i l a t e i n s i d e , 

(iv) i teračné stenčenie opakovaným použ i t ím nás t ro ja T h i n , 

(v) ods t ránen ie patologických š t r u k t ú r opakovaným s t r i edan ím nás t ro jov D i l a t e a T h i n , 

(vi) ods t ránen ie okrajových objektov nás t ro jom Remove edge o b j e c t s , 

(vii) separácia kriviek nás t ro jom Trace, 

(viii) spojenie a vyhladenie separovaných kriviek opakovaným s t r i edan ím nás t ro jov D i l a t e 

a T h i n , 

(ix) predĺženie kriviek nás t ro jom R e s t o r e e n d p o i n t s a konečný výpočet nás t ro jom 
C a l c u l a t e l e n g t h . 

K práci sú okrem samotného softvéru priložené snímky A , B , C a D vo formáte . B M P . 
Rozmery priložených snímok sú zredukované prevzorkovaním m e t ó d o u bil ineárnej inter
polácie. 
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